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Introduction to Microsoft Excel – Part 4 

Excel Pivot Tables 

A pivot table in Excel is essentially another form of a database. You can question your 
data in various different ways without actually changing your source data. 
Pivot tables are amazingly flexible and have lots of built in functions. They can suggest 
analysis in different ways and can immediately show you what your data looks like. 
To start with, here is a table full of data that I have prepared earlier. 
We could analyse this data using formulas and functions to solve a specific question, 
but that’s actually quite time consuming. 
Instead we can use Pivot Tables to analyse this data in seconds, and best of all, you 
don’t need to know any formulas or functions, it’s all just Drag and Drop. 
So here we are in our Excel spreadsheet and this relates to data about biscuit sales. 
I want to answer some basic questions, for example, How much Revenue did we earn 
from each of our customers, or how many orders did each one place with us. 
On the right hand side, I have created a table to answer these questions. 
So with customer #1 we made a little over half a million pounds of Revenue over the 
course of 92 different orders. 
Initially to build this table I have used formulas and functions, so when I click into this 
cell you can see that I used the SUMIFS function and here for the number of orders, I 
used a Function. This works fine, but it’s laborious. 
Perhaps we might have some other questions such as, how much Revenue did we 
earn for each customer and for each product, or how many orders did we get in a 
specific month. Now of course you could build out the table to answer these 
questions, but that takes a long time. 
Instead we can use Pivot Tables. Before we can insert a Pivot Table, we have to make 
our data into an Excel table. We have to prepare the data and ensure that there are 
no blank rows or columns. 
Also, you need to have Headers at the top of each column. Make sure that the 
headers are descriptive of the data underneath. 
For example, change Rev to Revenue, Our cost to just Cost. 
It’s easier if we turn all the data into an official Excel Table. The reason being that if 
we add data later, it can be added to the Pivot Table automatically later. 
To turn the data into a table, go up to the Insert Tab at the top and here’s the option 
to insert a Table. Alternatively, you can use the shortcut key is CTRL+T. 
Here I’ll press CTRL+T within the table and Excel automatically identifies all the data 
that should be in the table. It also asks if the table has headers, so check the Headers 
box, then Click OK. 
On the Table Design Tab over on the left hand side you can give the table a name. 
Let’s call it SalesData. 
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We are now ready to insert the Pivot Table. Up here under Table Design, I can 
Summarise with Pivot Table, or alternatively I can Click on Insert and here I can Click 
on Pivot Table. 
When you Click on Insert, it asks you what data you want to include in the Pivot Table 
and whether you want it on a separate sheet or added to the existing sheet, then 
Click OK. 
Excel then normally moves you to a new worksheet and here we have a new Pivot 
Table. 
If I Click on the Pivot Table, over on the right hand side, a new pane appears Called 
Pivot Table Fields. Within that pane are all these different Field Names, so for 
example we have things like; Customer, Order ID, Product, Units sold, Date, etc. 
You should recognise these from the Headers in the sales data table. Each Header 
title is referred to as a Field. 
Flicking back to the sheet with the sales data, here on the right hand side we have the 
table of data that I pulled together using formulas and functions. 
We want to recreate this same table using a Pivot Table just by dragging and 
dropping. 
First I have the Customer ID and then I have the ID number and they are shown on 
successive Rows. 
If we Click back into Sheet 1 (the new pivot table) let’s see how we can start building 
the same table. 
Here I see that I have the Customer. You can Click on this Field and Drag it down to 
the Rows and Drop it there. As soon as you do that, you see that the Pivot Table 
populates with your data. 
Next, I want to display the Revenue data. If I Click back to the data sheet, on the right 
hand side, you can see the total Revenue per Customer. This is the sum of the 
Revenue by each Indi dual Customer. 
Let’s go back to the Pivot Table and over here I have a Field called Revenue. Click on 
that and Drag it down to Values. 
You drag something down to Values if you want to calculate something, for example, 
if you want to Sum something or Count something, or if you want to calculate an 
Average. 
When you release the Drag, it automatically gives you the Sum of the Revenue, so 
here for Customer #1 you have a little over half a million pounds of Revenue, and if I 
Click back to the SalesData, you see that the number is exactly the same. Of course, 
the formatting is a little different. You can Click on the Revenue cell, go down to the 
number format and you can set it to currency. Remove the decimal places, then Click 
OK. 
Let’s now Click back to the SalesData and the last column shows the number of 
orders. 
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Let’s go back to the Pivot Table. On the right hand pane we have a Field called Order 
ID. Once again, Drag this down to Values. The Pivot Table updates, but it doesn’t 
match what is shown in SalesData. For customer #1 we have 92 orders, but the Pivot 
Table has a massive number. So what happened? If we look down at Values, this gave 
us the Sum of all the Order IDs. What we want is a Count of all the Order IDs. If you 
right Click on the Pivot Table cell showing the sum of Order IDs, you can change it to 
Summarise Values by. It is currently set to Sum, but you can change it to Count, you 
could also do Average, Max, Min or Product and there are more options down below. 
I’ll select the Count and now we have a Count of all the orders. 
If you click back to SalesData, it matches exactly now. 
So you see that you can build exactly the same view just by Dragging and Dropping 
with the mouse. There was no need to write a Formula or use a Function. 
Now we have our Pivot Table, it’s easy to use it to analyse our data and take different 
views of our data. 
Let’s say that we don’t want the Count of Orders any more. You simply Drag it out of 
Values and the Pivot Table updates automatically. Now you just see the Revenues. 
Maybe I just want to see the total Revenue. Go over to the right hand pane, under 
Rows, hover over Customer, see the X appear, when you release, you just see the sum 
of the total Revenue. 
Now pull the Customer in again. Click on the Customer Field and Drag it back to Rows 
and the Revenue is broken down by Customer again. It’s so easy. 
Looking at the table, on the left hand side, currently it is sorted by Customer number 
and not the Revenue. If you want to see which customer spent the most money, Click 
onto the Revenue column, then Right Click. Here is the option to Sort, select from 
largest to smallest. Notice that Customer #3 spent the most. 
If you want to change the order back to CustomerId, just Right Click in the Customer 
column and select Sort lowest to highest which then brings back the original view. 
You can play about as much as you like with the Pivot Table, you can’t do any 
damage! 
You can also Custom Sort the Customer list. Let’s say that I want to move Customer #4 
to the top of the list. Just Right Click on Customer #4 and all the way down at the 
bottom is an option to Move. Here I can Customer #4 to the beginning, or change the 
order as you wish. 
Another way to do this is to Click on Customer #4, Type CTRL+X, then select the 
position in the table that you want the data to appear and Type CTRL+V and the data 
moves. 
You can also Filter the list. Say that you just want to customers 1, 2 and 3 and see how 
much Revenue they generated. You can Click on the dropdown in the Header title 
showing customer numbers, you can then deselect All and just select the records that 
you want to display, eg 1, 2 and 3. 
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If you Click on the dropdown again, you can clear out the Filter to get back to the 
original view. 
Let’s say we want to see the Revenue for just Chocolate Chip Cookies. Over on the 
right hand side, there’s a Field called Product. If you Click back into SalesData, the 
column Product includes the type of biscuit. 
If you go back to the Pivot Table, select and Drag it down to Filters. When you 
Release, notice that there is a new section of the Pivot Table called Product with a 
dropdown selector. If you Click on it, you can select Chocolate Chip Cookie. You can 
also select multiple items if you want to, but I just want to select Chocolate Chip 
Cookies, so Click OK. The table will update and just show the Chocolate Chip Cookie 
Revenue. To remove the Filter, Just select Product on the right hand side and Drag 
that off the pane. The table then reverts to showing all the products again. 
If we look at the Revenue that the customer generated, we would also like to know 
the Percentage of the total Revenue each customer contributed, 
On the right hand side, Click Revenue and Drag it down to Values again. This creates a 
second display of Revenues in the Pivot Table. If you Right Click on the column, you 
get the option to show the Values as a Percentage of the column total. 
Now we see that Customer #3 drove 1.4 million pounds of Revenue or 30% of the 
total Revenue. 
To tidy up the Pivot Table we can change the Headers to make better sense. We can 
Click in a Header and type in a custom header name, eg % of Revenue. This makes 
more sense. Change the Sum of Revenue to Total Revenue. 
Perhaps you might want to see Revenue by Product. Over on the right hand side 
there’s the list of Fields. Select the Product and Drag it down to the Rows and place it 
under Customer. This causes the Pivot Table to update to show all the products under 
each customer. Against each customer number you can collapse or expand the 
Product list. 
You can also change the sort order. For example, put the Product above the Customer. 
This shows which Customer bought which Products. 
At the bottom of the right hand corner, remove the % of Revenue by dragging that 
Filed off the right hand pane. 
You can also take the Product and move it from Rows to Columns. Now we see the 
Customer as the Row and the Product as the columns and the value we see is the 
total Revenue. 
Notice that the layout in the right hand pane maps to the layout in the Pivot Table. 
You can also change the design of the Pivot Table. With your mouse within the Pivot 
Table, let’s Click on the Design Tab. 
Here we have a whole bunch of different things we can do to change the look of the 
Pivot Table. We can change the Pivot Table Style here. We could go for Red, or Yellow 
or go back to our Blue colour. You can also decide whether you want banded Rows or 
banded columns. 
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On the left hand side you can decide whether to show subtotals or not. 
There are options for showing Grand Totals or not. Turn it off for Grand Totals to 
disappear, or Click on Grand Totals for them to appear. 
You can also insert a chart to visually represent the Pivot Table. On the top Tabs, Click 
on Insert, then choose one of the recommended charts available. 
Another way is to Type ALT+F1 and this should insert a chart depending on your 
keyboard mappings. This may not work if your manufacturer has changed mappings. 
Here’s the chart representing my Pivot Table. Let’s say that I no longer want to see 
Product. Here I can Drag that out and you will see that the chart updates as well as 
the Pivot Table. The chart and the Pivot Table are tied together. 
To make it easy to analyse data you can Click on the Pivot Table Analyse Tab at the 
top. There is an option to insert a Slicer, I’ll select that. A new pane pops up and 
maybe I want to very quickly evaluate how much different types of product earnt, just 
check that box and Click OK. 
Here I see all my different products. Let’s say I want to see the Revenue for Chocolate 
Chip Cookies. Click on Chocolate Chip Cookies and it updates the chart and the table 
to show just the Revenue from Chocolate Chip Cookies. I can press the CTRL key if I 
want to select multiple products, so maybe I want to see Oatmeal Raison as well. 
Both the table and the chart update automatically. 
Click back into the Pivot Table, then go to Pivot Table Analyse. Here we have the 
option to insert a Timeline, then Check Date and this inserts a Timeline. You can 
select a time period and it will update the chart. 
You can Click on this Icon in the Timeline and this Icon on the Slicer and that will 
return it back to its original state. 
Say that you want to do further analysis on the Pivot Table but without losing the 
original Pivot Table. You can select the Pivot Table, Copy it and Paste it further down 
the page. 
Using the new Pivot Table, I want to see the Profit Margin. Over on the right hand 
side, I already have the Revenue and here I can Drag in the Cost. This gives me the 
Sum of the Cost which I don’t want. What I want is a Field for Profit Margin. 
Here I’ll remove the Cost. To create a profit margin we need a formula. To add this we 
go up to the analyse Pivot Table Tab, there we have Fields, options and sets, within 
this we select Calculated field. This opens up the calculated field dialogue. So we add 
the name Profit Margin. We need to insert the formula Margin=Revenue-Cost, this 
gives me the Profit Margin. Click on Add, then Click OK. Note that in the Fields pane, a 
new Field called Profit Margin has appeared. Profit Margin has been automatically 
added to the Pivot Table. 
Here I could remove the Revenue and now I can see my Profit Margin by Customer. 
I am now happy with my Pivot Tables, but I want to make sure if I add more data that 
all the views will update. 
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I we Click back to SalesData. I’ll go to the very bottom of the table and here I’ll add a 
new sale to a new Customer who will be Customer #6. 
Type in the new data – Order id = 456851, Chocolate Chip Cookie, 150 12/15/2022, 
£800, £100. 
Now go back to Sheet 1 where our Pivot Table is, but it doesn’t show the new sale 
data for Customer #6. With the Pivot Table selected, go up to Pivot Table Analyse, and 
see that there’s an option to Refresh. Click on that and magically the Pivot Table 
updates. 
One of the benefits of using Pivot Tables is that it doesn’t change your source data. 
So far, we have created Pivot Tables from scratch, but there is a cunning way to get 
Excel to create your Pivot Tables for you. If we go up to the top tabs, let’s Click on 
Insert and here’s the option for recommended Pivot Tables. You can Click that and it 
opens up a pane over on the right hand side, and here we see all these different 
items of data and how they could be displayed. 
If you like one of the Pivot Tables you could add it as a new sheet, or put it on the 
existing sheet. 
Back on the Home Tab, all the way over on the right hand side there is the option for 
Analyse Data. If you Click that, it will look through all your data and on the right hand 
side it will show you lots of different insights and here it generates a new Pivot Table 
for you. 
As you scroll down, you see that you can automatically generate a Pivot Table. 
Another neat feature is right up at the top, you can even ask questions about your 
data. 
As an example, How many different Products are there? It says that we sell six 
different types of biscuits. If you like that view, you can Click on Insert and it’s done. 
You don’t even need to know how to create a Pivot Table from scratch. 
If you know what it is that you want to find out then Excel will do all the heavy lifting 
for you. 
 
THE END 


